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Create a Documents Catalog
With the rushed pace of today’s business, how fast and accurately you can answer a client’s questions
makes a lasting impression. Here’s a technique you can use to store all your documents in a
database, so you can quickly find the one you need the moment that client calls.

By Jeff Nitka

IF you’re like me, you probably use your PC to
compose and store your documents. If you write
a lot of documents, it can be a formidable task to

find the document you need after days or weeks have
passed. If you’ve set up your document
subdirectories systematically and if you’ve carefully
named and added descriptions to your Write
documents, finding and them is easier. However, this
is much easier said than done. A number of issues
come into play when trying to establish a workable
system for saving and organizing documents:

• If several people are creating and saving
documents, document names are likely to reflect
the individual styles of their authors.

• A scant 11 characters are allowed for naming
documents (a maximum of eight characters to the
left of the period, and a three-character filename
extension). This limits the extent to which you can

assign recognizable and meaningful names to
your document files.

• The subdirectories required to adequately
categorize documents can become unwieldy as
the number of documents increases.

• Q&A’s ability to search for Write documents is
severely limited when compared to its database
searching capabilities.

• Although you can attach descriptions to your
Write documents (by pressing F6 while in the List
Manager), you can’t search on these descriptions
to find the document you need.

Fortunately, there are other ways to search and
retrieve documents stored on disk. One technique
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README.1ST
This month you’ll find an outstanding array of techniques to
help you work smarter with Q&A.

First, Jeff Nitka shows you how to use a database as a
kind of library card catalog for your letters, memos, and other
Write documents. Find out how to store key information
about your documents—along with copies of the documents
themselves, if you like—so you’ll be able to search for them as
easily as any database record.

Speaking of searching, sometimes you need multiple
search parameters to retrieve the information you need.
Though this is a simple enough task for a Retrieve Spec, it’s
out-of-bounds in an XLookup command unless you know the
workaround. In a second article, Jeff reveals his secrets for
extending the reach of your XLookups.

Q&A for DOS doesn’t provide tools for creating and
printing sophisticated forms, but a third-party product does.
Working hand-in-glove with your Q&A data, PerForm for
DOS lets you print your data in snazzy forms containing
graphics, shading, fancy fonts, and more. And, as Mike Bell
shows, you can integrate the two programs to work as one.

Bill Halpern helps you build a nifty “desktop” calculator
to compare your prices with the competition’s. His technique
is instructive for creating other kinds of database calculators
as well, and for situations when you need to input your data
in a spreadsheet-like form.

Finally, I’ll show you how to maintain a running
transaction history in a customer database. This way, when
you need an up-to-date chronology of billings and payments,
you won’t have to run a report or rummage through the
transaction file. The information you’re looking for will be
right there in the customer’s record.

During the past several months, I’ve alluded to the
possibility of a Q&A upgrade. All indications are that next
month I’ll be able to bring you big and definite news. If you’ve
been dreaming of more powerful data manipulation tools and
expanded relational-like features, stay tuned.

Tom Marcellus
Editor

Q&A User Group Bash Set for Mid-September
Plan now to attend the National Q&A User Group’s 5th Annual Bash, September
15–17, 1995, just outside Washington D.C. Hobnob with fellow Q&A enthusiasts,
meet and hear top Q&A developers, and attend solution-oriented seminars and
workshops. Bring your nagging Q&A questions and brilliant solutions. Spend
three relaxed and informative days with a fun-loving user group. Registration is
$45 for The Quick Answer subscribers (includes user group membership). Call
301-963-6377 for a fax-back flier containing the details.
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involves setting up a database to store information
much like a library card catalog. In a typical card
catalog, each card shows the author’s name, the title,
and where the publication can be found. The database
(call it CATALOG) that I’ll use to illustrate the
technique is similar, except that each record in the
database stores an entire document along with its
related information, not just the document’s location.
Figure 1 shows what CATALOG’s simple form design
looks like. The Date Written field is formatted for
dates, while the Customer, Person Addressed, Subject,
Written By, and Letter fields are formatted for text.
You can add any other fields that might help you
better identify and find your documents.

Using CATALOG
To use the CATALOG application, you compose your
document in Write in the usual way. Once you’ve
printed and saved it, make a note of its filename and
the subdirectory where it’s stored. (If you save the
document to your default documents subdirectory,
then you have to note only its filename.)

When you’ve saved the document and noted it’s
filename, you catalog it by adding a new record to the
CATALOG database. You can set default field values

Documents Catalog
Continued from page 1

for the Date Written and Written By fields or use the
Restrict Spec to create a list of persons who write
documents that wind up in CATALOG.

Next, you need to insert the letter into the
expandable Letter field. To do this, perform the
following steps, recording them in a macro to
automate the process. Open the CATALOG database
in Add Data mode, and Q&A will display a blank
data entry form. Here are the steps to record in the
macro:

1. Press Shift-F2, select Define Macro, and type the
macro identifier (or press Enter if you want to
assign a name to this macro with no macro
identifier).

2. With the recorder running, move the cursor to the
Letter field, and press F6 to expand it. Press F8 for
the Options menu, select Document, then select
Insert a Document. Q&A will prompt for the
filename.

3. Press Alt-F2 to pause the macro, so you can select
the document to be inserted.

4. Type in the path and filename of the document
you want to insert in the current CATALOG
record. For example, if the document is saved as
DOCUMENT.001 in the QA4 directory, just type
DOCUMENT.001. If it’s saved in a non-default
subdirectory named PRICES, type
PRICES\DOCUMENT.001.

5. Press Alt-F2 to resume the macro, press Enter to
insert the document, then press F6 to close the
expanded field. The document is now in the
database. Press Shift-F2 to end recording and save
the macro.

Figure 1.  A sample CATALOG record. Here the Letter field
is expanded, showing the top portion of the inserted
document. You can scroll through the document using the
mouse or arrow keys.

What About Q&A for
Windows?

Unlike Q&A for DOS 4.0, Q&A for Windows
doesn’t include commands for inserting a Write
for Windows document into a database field.
However, you can easily do so by taking
advantage of Windows’ Clipboard.

With the document onscreen in Q&A Write,
select the text by highlighting it, then pull down
the Edit menu and select Copy to copy it to the
Clipboard. Switch back to your current
database record (or start a new record), click
on the Letter field, pull down the Edit menu,
and select Paste to insert the document into
the field. If necessary, the field expands to
accept the document. You can then save the
record in the usual way.

With your documents stored in this
manner, you can search and retrieve them as
easily as you can in Q&A for DOS, including
searching on keywords, names, numbers,
dates, or phrases in the Letter field. —T.M.

What About Q&A for
Windows?
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Printing a Document Stored
in a Database Field

One of the potential inconveniences
associated with storing documents in a
database is that although the text and
paragraph formatting is maintained, you lose
any enhancements, such as fonts, boldface,
and headers. This won’t be an issue unless
you normally add enhancements to your
documents or you need to reprint the
enhanced original that you’ve deleted from
the hard disk.

To print a document stored in a
database record, retrieve the record, then
move to the field that contains the document.
Press F6 to expand the field, then press F2
and F10 to print. Make sure you expand the
field before printing; otherwise, Q&A will print
the entire record. —T.M.

Printing a Document Stored
in a Database Field

If you haven’t already
done so, enter the
information in the other
fields. These fields will help
you find and display the
document you’ve just
inserted. To make record
retrieval easier and more
consistent, don’t leave any
fields blank. When you’ve
filled in all the fields, save
the record and exit by
pressing Shift-F10, or save
the record and add another
one by pressing F10.

Retrieving documents
You can now retrieve and
sort any number of
documents according to
whatever parameters you
need. You can retrieve
documents by company
name or addressee, by
topic, by date range, or by writer.

One particularly powerful and handy feature is
that you can search the database on the Letter field
for any document that contains a keyword or key
phrase. For example, at the Retrieve Spec, you can
type ..content.. in the Letter field and press F10. Q&A
will retrieve all the records that contain the word
content in the Letter field.

If you designed the Letter field to be 15 lines,
you’ll be able to read approximately the first third of
the first page without having to expand the field. To
see the rest of the document, you can press F6 to
expand the field, so you can scroll down through the
document. If you need a hard copy, you can print the
document without leaving the record. See the sidebar,
“Printing a Document Stored in a Database Field.”

Other issues
There are a couple of possible drawbacks to this
application. The most notable is that you’re
duplicating data every time you copy a document
into the database and leave the original document on
disk. Unless your hard disk has lots of room, this
undesirable situation can be remedied by deleting the
original document once you’ve added it to
CATALOG, although it will take extra work should
you later need to reprint the letter. If your experience
is anything like mine, you’ll rarely, if ever, need to
reprint a document once it has been mailed or faxed.
What you’ll need is a quick way to display the

document to verify what
you told the client or
answer a question.

Another minor point is
that a Q&A database field
can store only up to 32K,
making it unable to handle
lengthy documents. On the
other hand, my experience
is that most documents,
unless they’re technical,
legal, or medical, contain
far less than 32K, which
works out to 15 or so
pages of text.

Using the application
as a card catalog
You can avoid duplicating
the document in the
database by using the
database to catalog only
the paths and filenames of
your documents. In other

words, instead of placing your documents in the
database, simply store their locations on disk, along
with whatever other pertinent information might help
you quickly identify and retrieve them. This way, you
can use the database as you would a real library card
catalog. Once you’ve searched the database by
whatever criteria is appropriate and have determined
the document’s name and location, it’s a simple
matter to switch to Write, and type in the path and
filename to display it. With this approach, you avoid
duplication of data on your hard disk, though you’ll
need several additional steps to find and display the
document.

I’ve developed both versions of the application
for several clients, most of whom have found the first
approach more to their liking. I prefer the first
approach as well. It makes retrieving and reviewing
documents much easier and faster, and I’ve had no
regrets after deleting the original documents once
they’ve been mailed or faxed.

[For more tips and tricks on using databases to store and
manipulate documents, see “Create and Use a Memo
Database” in the November 1993 issue and “Streamline
Cost Quotations with a Powerful, Automated System” in
the April 1994 issue. Copies of these back issues are
available from Marble Publications.—Ed.]

Jeff Nitka is pursuing a mathematics and computer science degree
at Rutgers University in New Jersey and works part time as a
software developer. Epoch Software, 908-874-3989.
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Edited by Dave Reid

Fix Mysterious
Corruption

One of my Q&A databases is
experiencing corruption. An
uninterruptable power supply (UPS) is
connected to the computer, so power
fluctuations aren’t the problem. The

symptoms occur at least once a day. Someone enters a
record and saves it with Shift-F10. The person then
tries to print a label for that record, and Q&A claims
the record doesn’t exist. The Retrieve Spec for the
label is Max1 in the Record Number field, and that
field is auto-filled during data entry with @Number.
But if the person types the Record Number in the
Retrieve Spec, Q&A finds it. What’s going on?

Denny Tretiak, Nipawin, Saskatchewan

This could be a problem with the index for the Record
Number field. To rebuild the index, go to the Main
menu and select File / Design a File / Customize a
File. Enter the name of the database, then choose
Speed Up Searches. The Record Number field probably
contains an S. If so, remove the S and press F10. (If
not, just press F10.) Again, choose Speed Up Searches.
This time, type the letter S in the Record Number
field, press F10, and Q&A will reindex the field. If you
have thousands of records, it can take a few minutes.
Don’t interrupt the process for any reason. The MAX1
Retrieve Spec should then work for all records.

Check for Overdue Accounts

I process and track orders using a multifile Q&A
application that includes an invoice, customer, and
inventory file. I also use an accounts receivable
database (ACCREC.DTF). When a collector calls a
client about unpaid invoices, a new record is added
to ACCREC, which contains a Date Invoice Paid
field. If this field is blank, it means the debt is still
outstanding. I’d like to add a feature to my
application. When a new invoice is being created, I
want Q&A to check the ACCREC file for a record
from that customer where the Date Invoice Paid
field is still blank. If one is found, a message should
appear saying “This client has overdue Invoices—
please get manager approval before shipping this
order.” Can I do this?

Larry Seale, Tulsa, Oklahoma

You can. Add an Unpaid Cust Num field to ACCREC.
You can place the field on of the back pages of the

@
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form, or in an out-of-the-way place. Then, add the
following programming to the ACCREC Program Spec:

Cust Num: >If Date Invoice Paid = ""
                   Then Unpaid Cust Num = Cust Num

Date Invoice Paid: >If Date Invoice Paid = ""
                    Then Unpaid Cust Num = Cust Num
                    Else Unpaid Cust Num = ""

No programming is required in the Unpaid Cust
Num field.

Make the Unpaid Cust Num field Speedy, so it
can be used as the key field in an XLookup. Also,
execute this programming on all your existing
overdue records. When you add a record, the program
copies the Cust Num to the Unpaid Cust Num field.
When you enter a date in the Date Invoice Paid field,
the program blanks the Unpaid Cust Num field. All
you have left to do is program the proper check in the
Invoice file. I’ll assume you’ll want to perform this
check as soon as the Cust Num is entered in the invoice:

Cust Num: >If @XLookup("ACCREC", Cust Num,
"Unpaid Cust Num", "Unpaid Cust Num") <> ""
Then @Msg("This client has overdue Invoices.
Get manager approval to ship order.")

The XLookup searches for this customer’s number in
the Unpaid Cust Num field. The Cust Num of a
customer who has had overdue invoices but has paid
them will no longer be in the Unpaid Cust Num field;
whereas, the program will find customers who have
one or more unpaid invoices and display the message.

Delete Q&A Write Files

I use Q&A Write for Windows and Q&A for DOS. I
like the way I can delete files without leaving Q&A
for DOS. Is there a way to delete document files
without leaving Q&A Write for Windows; that is,
without having to use Windows’ File Manager?

Linda Croft, Tennessee

No. Q&A Write for Windows doesn’t have a similar
capability. Actually, Q&A for DOS’s ability to delete
files while viewing them in a list is more than DOS
can do. In Windows, this job belongs to File Manager,
so Q&A Write for Windows would only be duplicating
this functionality. You can, of course, go to File Manager
without quitting Q&A Write—it’s one of the joys of
using Windows. Simply minimize Q&A Write, open
File Manager, delete the file, then maximize Q&A Write.

Update Imported Records

We’ve eliminated manual data entry by importing
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data from ASCII files. The Q&A file receiving the
data contains a lot of programming we need to
execute on each imported record. I can’t find a way
to run the programming statements during the
import. I’ve tried to Mass Update the records
following the import, but nothing happens. And I
don’t want to go through all 2000 records one at a
time, pressing F8 on each one. Do I have any options?

Dick Parker

Q&A can’t execute programming during an import,
so your best bet is to use Mass Update. After
importing the records, go to Mass Update for this file.
If you want to update all the records, leave the
Retrieve Spec blank. Otherwise, enter the restriction
that selects the records just imported. Press F10. At
the Update Spec, press F8 to set your Calculation
Options, set each of the options to Yes, then press F10
to begin the Mass Update. Q&A will display a record
count indicating its progress through the file. Because
the three Calculation Options tell Q&A to execute the
programming in the Program Spec, the process does
the same thing as pressing F8 on each record.

Create a Default Return Address

Whenever I create an envelope in Q&A Write for
Windows, I click in the upper left corner of the
envelope and type my return address. It’s beginning
to get tiring. Is there a way to have Q&A add my
return address automatically?

Bryan Cox, Minnesota

Yes. You can set the return address as a Preference. To
do this, pull down the File menu and select
Preferences. From the submenu, select Envelope. The
Envelope Preferences dialog box contains a box
named Return Address for Envelopes. Type your
return address there and click OK to save the settings.
The next time you create an envelope, Q&A will enter
the return address for you. This won’t effect
envelopes already created for existing documents.

Dave Reid is a Symantec senior support analyst providing second-
level assistance to the technical support representatives. He’s also
the coauthor of The Q&A 4.0 Wiley Command Reference,
published by John Wiley and Sons, and works as an independent
Q&A consultant. PO Box 12083, Eugene, OR 97440.
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Maintain Accurate History Records
Q&A’s Mass Update features let you
update all or a group of records in the
database at one time. One often cited
example is applying a uniform price
increase to all the items (or a subset of
them) in an inventory database. For
example, to raise your prices by 7
percent, your update program would
multiply the current price field by 1.07.
Easy enough. But if you use a sales
transaction database that retrieves

prices from the inventory database, you could be
setting yourself up for trouble unless you take an
additional step in your transaction database.

The problem is this: Suppose a customer calls and
asks you to verify the prices on an order from last
year, or your accountant needs your gross sales
figures from two years ago. If your programming in
the transaction database just looks up the prices in the
inventory database in the usual way, as in the
following typical program, anytime you change the
transaction record, the program will change its prices
to the current price, rather than leaving the prices at
which the items or services were actually sold:

#10: XLookup("Inventry", Part#, "Part#", "Price", Price)

You want to make sure your records maintain the
information current at the time the record was
created. You can do this by adding a simple If/Then
condition to your program. Just change the above
program to this:

#10: If Price="" Then
XLookup("Inventry", Part#, "Part#", "Price", Price)

The If/Then qualifier ensures that Q&A looks up the
price only when the Price field is blank, such as when
you’ve added a new sales order or deliberately
blanked the Price field in order to retrieve the current
price. The second part of the statement (Then) is
executed only if the first part (If) is true. You’ll find
other situations where this kind of If/Then logic is
useful, such as with customer credit card numbers,
expiration dates, quantities on hand, dates, sales reps,
shipping addresses, and so forth. By incorporating If/
Then logic in your programming in this manner, your
records, recent or historical, will always reflect the
data current at the time they were created.

William Halpern

Have a nagging question? Send it to @Help, The Quick Answer ,
Marble Publications, Inc., PO Box 9034, Gaithersburg, MD 20898-
9034 or fax to 301-424-1658. Include your name, address, phone

number, your Q&A version number (and whether DOS or Windows), and a
detailed description of the problem. We will publish those questions we feel
are of general reader interest. Individual responses aren’t possible.
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Review:

Print Your Data in
Professional-Looking Forms
You can print your Q&A data in sophisticated forms with graphic elements, shading, fancy
fonts, lines, and boxes. You don’t need Windows, your users don’t have to learn anything
new, and you can control printing without leaving Q&A.

By Michael Bell

I’M an attorney, and for years I’ve been printing
my Q&A database information in sophisticated
forms, such as the Department of Housing and

Urban Development’s HUD1-A form shown in Figure
1. It’s so easy that I feel guilty for not having shared
my secret with you sooner.

The secret is integrating Q&A with PerForm 2.1, a
powerful forms creation package from Delrina, maker
of the popular WinFax Pro. Though PerForm 2.1 runs
under DOS, its Windows-like graphical interface
makes it a snap to design just about any form you
could imagine, right down to the smallest detail. And
because you can place fields on your forms, you can
fill them with information from your Q&A database.

To make PerForm even easier to use, you can pass
your merge printing instructions to it from a DOS
batch file. This way, you can launch PerForm from
Q&A with instructions on what to print, then be
returned to Q&A when printing is finished. Q&A and
PerForm work together smoothly, even for the most
complex form printing tasks.

PerForm Features

PerForm 2.1 includes these three modules:

• PerForm—the graphical mouse-driven interface
you use to create forms from scratch or
customize the predesigned forms that come
with the package.

• PerFill—the data entry module you use to type
the data to merge with your form. You won’t
need this module if you’re using your Q&A data.

• Output—the printing module that merges your
Q&A data and prints the form. PerForm creates
.GEM output files so that lengthy and complex
forms can require up to 2M of printer memory.

PerForm Features

Figure 1.  An 8.5 x 14-inch HUD1-A form
created in PerForm 2.1 for DOS, then auto-filled
with data from a Q&A for DOS database.
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Inside PerForm
PerForm comes with more than 100 ready-to-use
fillable forms, including bills of lading, invoices,
purchase orders, credit and employment applications,
government forms, health and dental insurance claim
forms, work orders, time sheets, quote forms, and
more. Additional pre-designed form packages are
available separately.

PerForm imports graphic images—company
logos, for instance—in popular formats like .TIF,
.PCX, .GEM, and MacPaint. Though PerForm runs
under DOS (it even runs on an XT), you work with
your forms in a true WYSIWYG graphical
environment. The program is
fast, flexible, and its output
quality is superior. Full
installation, which isn’t
required to merge print an
existing PerForm form with
Q&A data, takes only 3.5M of
disk space.

Creating forms and fields
PerForm makes it easy to create
attractive forms with fillable fields. You position and
size your fields and graphical elements by clicking
and dragging them onto the form. To assign attributes
to a field, you double-click on it. You can then
designate it as a fixed or fillable field; assign a field
name and type to it (text, number, money, date, and
so forth); choose the justification you want; then
apply your font, enhancement, or other appearance
attribute. Though you do this a field at a time,
PerForm lets you assign attributes to groups of fields.
A handy comb feature lets you quickly create
duplicate boxes for invoice line-items and the like.

PerForm’s tab order (the order in which the form’s
fields are filled) defaults to the order in which you
added the fields to the form, but you can easily
change it to accommodate the same order the data
will flow in from your Q&A export file.

Create the Q&A export procedure
To get the most from PerForm, you’ll want to create a
push button procedure that does all the work,
including creating the export file containing your
Q&A data, launching PerForm, merge printing the
selected form(s), and returning you to Q&A.

If you’re exporting all the fields from your
database and the tabbing order of your PerForm form
matches the order of the fields in the database, you
won’t need to fill out a Merge Spec.

Otherwise, select File / Export / Standard ASCII,
and enter the database and export file names. Press
F10 to bypass the Retrieve Spec, and at the Merge
Spec, number the fields in the order you want them in
the export file. (Press F1 from the Merge Spec for

online help.) The export order must match the
tabbing order in the PerForm form you’re using.
When you’ve filled out the Merge Spec, press
Shift-F8, assign a description to it, and save it.

Create the batch file
To pass your merge printing instructions to PerForm,
you’ll need a DOS batch file you can install as an
alternate program on Q&A’s Main menu. The batch
file I use to print my HUD1-A form looks like this:

FPRINT $O C:\FORMS\OFFICE\FAX1.FRM $DELIMITED
C:\QAFILES\TOFORM.TXT C:\QAFILES\TOFORM.FIL

  The first part of this batch
file invokes PerForm’s FPRINT
program and specifies the form
(.FRM) to be printed. Be sure to
include the full path name. The
$O switch specifies that the
form and data file are to be
merged. (You can optionally
print empty forms for filling
out manually).

  The $DELIMITED
parameter tells PerForm that the data file is a
delimited ASCII file. PerForm’s default import format
is comma delimited ASCII with quotes around values
and a carriage return between records. This happens
to be Q&A’s default export format, so no additional
file manipulation is required to merge your Q&A data
with PerForm forms.

The paths and filenames are specified next—the
ASCII (.TXT) export file generated by Q&A, followed
by the fill (.FIL) file that PerForm creates from the
.TXT file to merge with the form (.FRM) file.

Before you create your batch file in Write, be sure
your page width for imported documents is wide
enough to allow the entire batch file command to fit
on one line. To access the Define Page for Imported
Documents screen, choose Write / Utilities / Set
Global Options / Change Import Defaults. Be sure to
save the batch file to ASCII format by pressing Ctrl-F8.

Installing the batch file on the Main menu
To install the batch file as an alternate program on
Q&A’s Main menu, select Utilities / Set Alternate
Programs. On an available Alternate Program line,
type the path and name of your batch file, such as
C:\QA4\FORM.BAT. On the Menu Selection line, type
in the text you want to appear on the Main menu,
such as 1 - Forms. Press F10 to save your changes, and
Q&A will add your new selection to the Main menu.

Record the macro
Finally, record the macro that automates the export
and merge printing process. Have the macro pause
for you to fill out the Retrieve Spec portion of the

PerForm 2.1 for DOS
from Delrina Technology
$99
($69 for The Quick Answer subscribers)
6830 Via Del Oro, Suite 200
San Jose, CA 95119-1353
800-268-6082, extension 6201

PerForm 2.1 for DOS
from Delrina Technology
$99
($69 for The Quick Answer subscribers)
6830 Via Del Oro, Suite 200
San Jose, CA 95119-1353
800-268-6082, extension 6201
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export procedure, so you can choose the record(s) you
want merged with the form. You can create batch files
and macros that merge single databases with single
forms files, single databases with multiple forms,
multiple databases with single forms, and multiple
databases with multiple forms.

You can set PerForm’s Output module so it prints
immediately when invoked, or pauses for manual
input. When preparing to merge print a form, if
PerForm finds an existing .FIL file by the same name,
it pauses for you to tell it whether to overwrite the
file, append the new data to it, or cancel the
procedure. To avoid this interruption, my Q&A macro
deletes the existing .FIL file before invoking PerForm.
Here’s the macro I use to automate the form printing
process. Its final action runs the 1 - Forms selection on
the Main menu that invokes the batch file:

<begdef><nokey><name>"print<sp>form"<vidon><esc><esc>
<esc><esc><esc>wg<capsf4>c:\qafiles\<enter>toform.fil
<f3>y<esc><esc><esc><esc><esc>fues<capsf4>c:\qafiles\
topform<enter>toform.txt<enter>y<wait><enter><f10><f10>
<esc><esc><esc><esc>1<enddef>

You can structure your macro in whatever way
works best for you, and change PerForm’s defaults to
accommodate your needs. For example, if you’re
merging several databases with multiple forms, you
can add pauses to the macro to select each database in
turn, along with their related saved Merge Specs.
    If you use forms in your business and want your
Q&A data in the best-looking forms you can get, you
can’t go wrong with PerForm 2.1 for DOS.

Mike Bell, an attorney in Rockville, Maryland, is president of Marble
Publications, Inc. and publisher of The Quick Answer. He’s also
creator of the Q&A for DOS Turbo Pack and president of the National
Q&A User Group. Prodigy NEPY97A, CompuServe 73370,1575.

Figure 1.  A Q&A for DOS Write document in a window.
(Windows’ Program Manager is in the background.) You can
mark, copy, and paste text between DOS apps running in
Windows. Press Alt-Enter to return to full screen mode, or
click outside the window to minimize Q&A.
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commands on the Window Control menu as shown in
Figure 1.

Q&A 4.0 for DOS comes with two Windows
Program Information files (.PIF), QA1MB.PIF and
QA640K.PIF, and a Windows icon file (QA.ICO). (You
can see the Q&A for DOS icon just outside the upper
right corner of the window in Figure 1.)

While running Q&A for DOS in a window, you
can size and move the window, and select a larger or
smaller font. To change font size, choose Fonts from
the Window Control menu. Running Q&A 4.0 for
DOS in Windows doesn’t prevent you from running it
in DOS in the usual way.

Tom Marcellus

If you run Q&A 4.0 for DOS in
Windows 3.1, not only can you quickly
switch between your programs by
pressing Alt-Tab, you can take
advantage of Windows’ Clipboard to
copy and paste text between Q&A and
other applications. For example, you
might want to quickly copy an address
block, a programming statement, or
other Q&A text to paste elsewhere.
With Q&A for DOS running full screen,

press Alt-Spacebar to run it in a window and display
the Window Control menu. (Alt-Enter switches to
window mode but doesn’t display the Window
Control menu.) Figure 1 shows a Write document
in a window with its Window Control menu
displayed.

You can display the Window Control menu
by clicking on its icon in the upper left corner of
the Q&A for DOS window (or you can press Alt-
Spacebar). To copy a block of text to the Clipboard,
click on Edit, then click on Mark (or press E then
K). Use your mouse to highlight the text you want
to copy (or position the cursor, then hold down
the Shift key while using the cursor keys to select
the text) and press Enter. You can press Alt-Enter
at any time to switch back to full screen mode.

The text you selected is now in the
Clipboard. You can paste it into any Windows
application by pressing Ctrl-V or by using the
Paste command from the Edit menu, which is
available in most Windows applications. Or, you
can paste the text into another DOS application
running in a window by using the Edit and Paste

A Clipboard for Q&A for DOS



10 The Quick Answer  ▲  July 1995 © Marble Publications, Inc.

IN the June 1995 The Quick Answer (page 8), Dave
Reid described how to use an expanded field to
store a history of changes to a patient's medical

record. You can adapt this technique to post transactions
to a history field in your customer record.

Figure 1 shows a simplified invoice form (without
the line-items). We want to post Date, Invoice No, and
Amount to the matching customer record (see Figure
2) so we'll have an up-to-date transaction summary
for the customer without having to create and run an
invoice report.

You'll need three fields, a little programming, and
a Posting Spec. Here are the steps:

1. Add a text field named Post to Trans History to the
invoice file (See Figure 1) to serve as the source
Post field. Add a programming statement, such as
the following, to execute when the Invoice No,
Date, and Invoice Amount fields have been filled.

> Post to Trans History = @Str(Date) +
  " Invoice " + @Str(Invoice No) +
  " $" + @Str(Invoice Amount)

2. Add two text fields to the customer database, Last
Trans and Trans History. (See Figure 2.) Last Trans
serves as the target Post field, and Trans History
stores each transaction as a line-item. Add a
programming statement such as the following to
the Last Trans field:

#100: If Last Trans <> "" Then
    {Trans History = Trans History + "
" + Last Trans; Clear(Last Trans)}

Be sure to press Enter after typing the double
quote mark at the end of the second line. This
ensures that each transaction in the Trans History
field appears on a separate line.

3. Create and save a Posting Spec to post the last
invoice (or the last group of unposted invoices) to
the customer file. Fill out the Posting Box as follows:

Post the Value of field:  Post to Trans History
... into external field:  Last Trans
When the field: Acct No
... matches the external field Acct No  in CUSTOMER.DTF
Operation: Replace

Before naming and saving the Spec, press F8 to
display the Auto Program Recalc screen, and set
Calculation Statements to Yes.

How the procedure works
When you enter an invoice, the programming creates
a summary of the transaction by copying the Date,
Invoice No, and Invoice Amount to the Post to Trans
History field. Your Posting Spec then posts this value
to the Last Trans field in the matching customer record,
where the programming copies it to Trans History.

You can adapt this technique to add payments to
the Trans History field as well. The customer's record
can then show invoice billings as well as payments
against those invoices, all in chronological order.

Tom Marcellus is editor of The Quick Answer and author of PC
World Q&A Bible, published by IDG Books.

Figure 1. An invoice record for Mitchell and
Company, account number MITCH46311. Note
that the Post to Trans field contains the Date,
Invoice No, and Invoice Amount.

Use Posting to Maintain
Transaction Histories
Have fast access to a summary of customer transactions by posting them to
a history field in the customer file.

By Tom Marcellus

Figure 2.  The customer record for Mitchell and
Company after the transaction has been posted.
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Using XLookups with
Multiple Search Criteria
Ever try to retrieve information from an external file based on two matching fields? Q&A’s family of
XLookup commands won’t let you do it, but you can work around the limitation.

By Jeff Nitka

Q&A’s Retrieve Spec lets you enter multiple
parameters to search for the database records
you need. For example, you can type ..Smith

in the Customer Name field, and NJ in the State field
to find your customers in New Jersey that end in
Smith. Multiple Retrieve Spec parameters help you
refine and narrow your searches.

Unfortunately, Q&A won’t allow you to specify
multiple key value parameters in XLookup
programming statements designed to retrieve
information from other databases. If you want to use
XLookup to retrieve a value from another database,
you’re limited to only one value as the matching key
value.

Going about it another way
Using a workaround, however, you can successfully
include multiple key values in XLookup statements
and @XLookup functions. This way, your external
lookups can find the matching record in the other file
based on two or more values in it. The technique isn’t
complicated. It involves adding a new field to the
external lookup database (the database from which
the Xlookup retrieves its information) and
programming it to store a concatenated value that
represents the fields crucial to the search.

For example, if you concatenate Account No 3455
and Part No H34XX in the lookup database, you get
the new combined value 3455H34XX. Your XLookup
can search for this concatenated value and, if found,
return the information you need from that matching
record. In effect, you’re using multiple search
parameters in a programming statement, which can
help you more effectively restrict your searches.

The technique works equally well in Q&A for
DOS and Q&A for Windows, though I’ll focus on
Q&A for DOS. I’ll demonstrate using a common
example where the prices a company charges for
some or all of its products vary depending on the
customer who is purchasing them. Customer A,
because he or she is a high volume customer and lets
you win at golf, might receive a lower price on certain
items. Customer B, who gives you a piddling order
and expects you to deliver it within the hour, pays the

regular price, and so forth. Other uses for the
technique include retrieving a customer’s address
when the customer has one account number but more
than one shipping address or retrieving information
on a particular lot number for a certain product code.

Database design
In this simplified example, the external lookup
database stores records of items and prices by
customer number. Here are the fields along with their
formatting codes for the sample ITEMS database:

CustNo   :  T
Cust Name:  T
ItemNo   :  T
Price    :  M

Suppose you enter data in another database that
stores information about customer orders. Such a
database named ORDERS might include these fields:

CustNo          : T
Cust Name       : T
ItemNo          : T
Price           : M
Quantity Ordered: N
Extended Cost   : M

Let’s assume you’re adding a new record to this
second database. You’d first enter the customer
number in the CustNo field, and your XLookup
program would retrieve the Cust Name from your
customer name and address database. You enter the
ItemNo next. On exiting the ItemNo field, your
XLookup program retrieves the price of the ItemNo
for the specific CustNo, and the Extended Cost is then
calculated using the data now in the record.

Changing the information in a record is no
problem. No matter which fields you edit, the
programming maintains the integrity of the data in
the record.

Redesigning the files
To incorporate the multiple Key value XLookup
technique, choose Redesign a File and add a new
CustNo-Item field to the ITEMS database. It now
includes these fields:
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Caveat User

There’s one drawback to this
technique. Because XLookups check
only the first 15 characters in the
external key field to determine if
there’s a match, the number of fields
you can reliably search on is limited.
For example, if customer numbers
are normally five characters, your
item numbers are six characters, and
you add the “*” that serves as the
value separator, then you have only
three characters remaining to further
restrict the search. If the
concatenated field value exceeds 15
characters, your XLookup won’t be
reliable past the 15th character.

Caveat User
     CustNo: T
  Cust Name: T
     ItemNo: T
      Price: M
CustNo-Item: T

Save your redesign, go to the
Program Spec for ITEMS, and
enter the following field ID
numbers and programming:

CustNo:    #1
ItemNo:    #2
CustNo-Item: #3: #3 = #1 + "*" + #2
Price:    #4
Cust Name:   #5

Before you save your new
Program Spec, press F8, and
enter the number 3 in the On
Exit Field ID line. Press F10. This
tells Q&A to execute the
program in field #3 when you
save the record and ensures that
the CustNo-Item field always
contains the concatenated CustNo and the ItemNo
values separated by an asterisk. Press F10 to save the
Program Spec.

Customize the file
To add more reliability to the database, you should
further customize it. Go to the Customize File menu
for ITEMS and choose Restrict Values. In the Restrict
Spec, type an exclamation point (!) in both the
CustNo and the ItemNo fields. This way, you won’t
be able to save a record if either the CustNo or
ItemNo fields is blank. Next, go to the Speed-up Spec
(also on the Customize menu) and type an S in the
CustNo-Item field to make it Speedy (indexed).

It’s now time to return to the primary ORDERS
database to program it for your restricted lookups.
The programming is as follows:

CustNo: >#1: Goto #3

Cust Name: #2

ItemNo: >#3: Goto #5

Price: #4: If #1 <> "" and #3 <> "" and #5 <> ""
      Then {
      XLookup("Items",#1+"*"+#3,"x#3","x#4",#4,

"x#5",#2); #6 = #4 * #5
}

Quantity Ordered: >#5: Chome

Extended Cost: #6

Press F10 to save the Program Spec. Now, go to
the Restrict Spec and type an exclamation point in the
CustNo, ItemNo, and Quantity Ordered fields to
make them required. This ensures that your records

always include the information
required for the XLookup and
that the Quantity Ordered field
isn’t left blank if the XLookup
fails and you try to save the
record anyway.

While you’re at it, you
should make the Cust Name,
Price, and Extended Cost fields
read-only since the information
they contain is wholly
dependent on the XLookups.
(Read-only fields is on the
Programming menu.) Finally,
change the Calc mode in the
database to automatic. To do
this, open the database in Add
Data mode, but before entering
any data, press Shift-F8, select
Automatic, then press Enter.

The technique in action
When you add a record to the ORDERS database, you
first enter the customer number. Because your Restrict
Spec requires a value in this field, Q&A won’t let you
continue until you’ve entered one. The same is true
for the ItemNo and Quantity Ordered fields. Once
you’ve filled these three fields, the program in field
#4 (Price) executes, and the Price and Extended Cost
appear in their respective fields. If you’re finished
with the record, you can press F10 to add a new one,
or press Shift-F10 to save the record and exit. If you
feel you’ve made a mistake in any field, simply return
to the field and enter the new data. The program will
recalculate the Price and Extended Cost fields
automatically. The XLookup statement in field #4
(Price) searches the external ITEMS database for the
concatenation of fields #1 and #3. Here’s the matching
search key , which is how the unique key value in the
ITEMS records is structured:

#1 + "*" + #3

If the search fails?
If you receive a message indicating the XLookup has
failed, one or more of the following errors has
occurred:

• The CustNo value you entered is incorrect.

• The ItemNo value you entered is incorrect.

• Both the CustNo and ItemNo values are incorrect.

• The external database doesn’t contain a record
that matches the CustNo and ItemNo values.
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To check a failed XLookup, try reentering the data
after you’ve made sure it’s correct. If the XLookup is
still unsuccessful, then check the external file to verify
that a matching record actually exists.

I often incorporate this technique in my
XLookups because the information I need to retrieve
can depend on the data in more than one field. I’ve
used this technique to determine if a purchase order
for a customer already exists, if a lot number for a
product has been reserved for a customer, if a

different price structure exists for a customer, if the
customer has multiple shipping addresses, and so
forth. Once you’ve added the concatenated field to
the lookup database along with the programming,
you’ll welcome the increased data entry ease and
reliability it brings.

Jeff Nitka is pursuing a mathematics and computer science degree
at Rutgers University in New Jersey, and works part time as a
software developer. Epoch Software, 908-874-3989.
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When working with date values, it’s
important to remember that Q&A
stores dates internally in the format
yyyy/mm/dd, where yyyy is the year, mm
is the month, and dd is the day. For
example, Q&A stores January 1, 1995,
as 1995/01/01.

The following programs show how to
extract a date’s components, assuming
you have fields named Date, Day,
Month, and Year:

Day   = @Right(Date, 2);
Month = @Mid(Date, 6, 2);
Year  = @Left(Date, 4);

If you’re using the @Date (current date) function
instead of a Date field, modify your program like this:

Day   = @Right(@Date, 2);
Month = @Mid(@Date, 6, 2);
Year  = @Left(@Date, 4);

If you want only the last two digits for the year,
change this:

@Left(@Date, 4)

To this:

@Mid(@Date, 3, 2).

[You can also use Q&A’s built-in date functions to parse a
date value. Here’s a program to separate the day, month,
and year from the date in the Date field:

Day=@Dom(Date); Month=@Month(Date); Year=@Year(Date)

Use @Dom$ and @Month$ if you want Q&A to return
the full name of the day or month, such as Tuesday or
July.

Incidentally, Q&A stores dates in the yyyy/mm/dd
format for a very good reason: so their chronological order
matches their alphanumeric order for sorting and other
date operations.—Ed.]

David Dvorin, Phoenix Solutions, Somerset, New Jersey

Separate Date Components

Amplification

Program Spec field ID numbers were inadvertently
omitted from “Create and Print Invoices with
Unlimited Line Items” in the May 1995 The Quick
Answer. The field ID numbers are as follows:

ROLODEX.DTF INVOICE.DTF
CustNo: #1 Transaction No: #1
Name: #2 Date: #2
Address1: #3 Cust Number: #3
Address2: #4 Customer PO#: #4
City/St/Zip: #5 Product Description: #5

Quantity Ordered: #6
HISTORY.DTF Cost: #7
InvNo: #1 Extended Cost: #8
Date: #2 Line No: #9
Max: #3
Customer: #4
CustNo: #5

( HISTORY.DTF, continued)
Q1 through Q0: #10 through #19
Des1 through Des0: #20 through #29
C1 through C0: #30 through #39
Ex1 through Ex0: #40 through #49
PO#: #51
OrdDate: #52
Total: #50

In the eighth paragraph of the second column of
page 5, “. . . in reverse transaction number order . . .”
should read “. . . in reverse LINE NO order . . .” We
apologize for any inconvenience the omission and
error might have caused.
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Create a Price Analysis Calculator
How does your price for a good or service stack up against the competition? What’s the average market price?
“What if” you raised your price a bit? Lowered it? This valuable information, and more, is instantly available with a
handy “desktop” calculator you can assemble in half an hour.

By William Halpern

TO survive in the business world, you have to
be competitive. A fair market selling price
doesn’t mean you’re competitive. You might

be pricing yourself out of the market or selling far
below what the traffic will bear.

Performing a competitive price analysis on a
range of products or services can be tiresome and
tricky. You could benefit from a handy calculator that
performs a market comparison and analysis for you
and allows you to play “what if” with your pricing.
Such a calculator should let you see at a glance where
your prices stand with respect to the competition and
how a fair market price might affect your bottom line.
You can create a Q&A database, such as my
SALECOMP.DTF, to perform the number crunching
and display the comparative data. (See Figure 1.)
Though the database shown here was created in Q&A
for DOS, you can create it in Q&A for Windows as
well.

SALECOMP lets you to enter your selling price
for a given item, along with up to four competitor’s
prices and the dates those prices were valid. The
database then calculates the multiplier or percentage
of each competitor’s price against your calculated
selling price. If you’ve entered one or more
competitive prices, it also calculates an overall
average competitive price (the Mkt Avg Price field)
along with the average market percentage related to
your selling price.

(You can add features to the database to calculate
costs based on time, materials, labor, overhead,
processing, and so forth).

While reviewing the data, you can plug in (in the
Desired Price field) what you feel might be a good
selling price for the item. SALECOMP then reveals
where you stand in relation to the average market
price (Percentage of Market Price) and your original
calculated selling price (Our Price Multiplier). If the
figures aren’t appealing, you can change the desired
price and the database recalculates the comparisons.

You can add another competitor’s price or drop
one from the list, and the database recalculates the
comparisons. The only requirement is that for a
competitive analysis, there must be an entry in the
first line of the Competitor Data table.

With some minor modifications, SALECOMP can
handle any number of competitive pricing
comparisons, and no matter how many fields you add
for comparison, the calculated averages will be based
only on those you fill in. If you have no competitive
data, the database sets the average multipliers and
prices equal to 1 and your price, respectively.

You can use the various calculation results in
other databases, such as a sales transaction database.
You can change your desired price, add, change, or
delete competitive data, and the database will
continue to perform accurate comparisons.

Field naming
The heart of the database is the Competitor
Data table. Because it must look and act like a
spreadsheet, none of its 16 fields include
labels. I used the following convention to
assign names to these fields at the Field
Names Spec:

• The four fields under the Name column are
named Name Line 1 through Name Line 4.

• The four fields under the Sales Price
column are named Sale Price 1 through Sale
Price 4.

Figure 1.  Sample SALECOMP record.
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• The four fields under the Sale Factor column are
named Sale Factor 1 through Sale Factor 4.

Programming
Programming for SALECOMP isn’t as complex as
you might think. Listing 1 shows the field names, the
Program Spec field ID numbers assigned to them,
along with the statements and any messages
conditionally displayed.

Listing 1.  Program Spec for SALECOMP.

Calculated Sale Price
#100

Name Line 1
#200

Sale Price 1
>#240: If #200<>"" and #240="" Then

 { @Msg("Unit Cost For This Vendor Must Be
      Entered");

 Goto #240 };
 If #200="" Then #280="" Else #280=#240/#100

Sale Factor 1
<#280: Cnext

Name Line 2
#210

Sale Price 2
>#250: If #210<>"" and #250="" Then

 { @Msg("Unit Cost For This Vendor Must Be
      Entered");

 Goto #250 };
 If #210="" Then #290="" Else #290=#250/#100

Sale Factor 2
<#290: Cnext

Name Line 3
#220

Sale Price 3
>#260: If #220<>"" and #260="" Then

 { @Msg("Unit Cost For This Vendor Must Be
      Entered");

 Goto #260 };
 If #220="" Then #300="" Else #300=#260/#100

Sale Factor 3
<#300: Cnext

Name Line 4
#230

Sale Price 4
>#270: If #230<>"" and #270="" Then

 { @Msg("Unit Cost For This Vendor Must Be
      Entered");

 Goto #270 };
 If #230="" Then #310="" Else #310=#270/#100

Sale Factor 4
<#310: Cnext

Mkt Avg Price
#350: If #280 <>"" Then

 { #360=@Avg(#280..#310);#350=#360*#100 };
 If #280="" Then  {#360="1.000"; #350=#360*#100};
 If #370="" Then #370=#350; If #380=""

      Then #380=#360

Avg Mult’r
#360

Our Desired Price
#370: #380=(#370/#350)*100;

 #390=#370/#100;
 If #280 ="" Then {#380="1.000";#390="1.000"}

Percentage Of Mkt Price
#380

Our Price Multiplier
#390

When you’ve completed and saved the Program
Spec, set the programming to Automatic Calculation.
This way, Q&A can perform its calculations and
display the results as soon as you make a change to
any field in the record. Open SALECOMP in Add
Data mode. When the blank record appears, press
Shift-F8, change calc mode to Automatic, make sure
that Main program before field exit? is set to No, then
press F10.

Your price analysis calculator is now ready for
action, and you’re on your way to an improved
bottom line!

Bill Halpern is executive vice president of Professional Computer
Technology Associates in Newtown, Pennsylvania, and author of
Pinnacle Publishing’s The Quick Answer Focus special report on
Macros and Custom Menus. Bill has been designing and installing
Q&A business applications for the past eight years, and teaches
Q&A at two community colleges. 215-598-8440, CompuServe
71023,356.
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Quick Delete During Data Entry
select it. You can then delete or copy it to the
Clipboard the same way.

If you’re using a mouse, you can double-click on
the field value to select it. If the value contains one
or more spaces, though, you’ll need to select it by
dragging the mouse from one end of the value to the
other.

You can also use the Cut, Copy, and Paste
commands on the Edit menu to delete, copy to the
Clipboard, and paste from the Clipboard.

Tom Marcellus

To quickly clear the contents of a field,
press Shift-End, then Delete. Shift-End
selects (highlights) the field value, so
you can also use this command to
copy it to the Clipboard in order to
paste it elsewhere. For example, you
can press Shift-End then Ctrl-C to
copy a field to the Clipboard, then
press Ctrl-V to paste it. For a multiline
field, you can press Ctrl-Shift-End to
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Add Comments to Your Macro Files
If you use Write to compose your
Q&A macros (instead of recording
them via the Macro menu), it can help
to know that Q&A will treat any line
beginning with an asterisk (*) as a
comment. If you create complex
macros, comments can provide a
quick reminder of what your macros
do. Here’s what a commented Q&A
macro might look like:

*Prints Monthly Expense Report.
*Prompts at Retrieve Spec for Month and Year.
*Prompts at header for Month and Year.
*Prints report to LPT1.
*Hot-key Alt-R. Created 2/15/95.
*——————————————————————-
<begdef>
<altr><name>“monthly<sp>expense<sp>report”<vidon>
rpexpenses<enter>monthly<sp>expense<sp>summary
<f10>y<tab><wait><enter><tab><lft><wait><enter>
<f10><f10><f8><dn><dn><dn><dn><end><sp><wait>
<enter><home><capsf6>2<end><f10><f10><esc>
<enddef>
*——————————————————————-

I created an extensive macro file (more than 30
printed pages) that included many complex tasks as
well as a custom menu structure. I added comments
to document each macro’s purpose, assumptions,
hot-key, and other important information.

At first, I was afraid the comments would make
the macro file too large for Q&A’s macro buffer.

However, I noticed that when I saved a macro file
via the Macro menu, Q&A stripped out the
comments. Assuming the save operation saves only
what’s in memory, the only other way comments
could be ignored is when you load a macro file.
Thus it seems that comments have no affect on
macro buffer usage. Accordingly, if you use Write to
create and edit your macros, add all the comments
you need. You might find them invaluable.

[You can take advantage of Dave’s technique and still
record a macro interactively and save it via the Macro
menu. Simply save it to a new filename when you’re
finished recording, then use the Insert Document
command on the F8 Options menu to copy the macro
from the new file to your commented macro file. Add
your comments to the new macro, resave the file by
pressing Ctrl-F8, and load it into memory using the
Shift-F2 Get macros command.

You can also protect a macro file. This way, you can’t
save a macro to it—or record one while that file is in
memory—because Q&A won’t display the Macro menu.
Protect a macro file using the File / Design File /
Customize Application / Protect Macro File menu path.
Type in the name of the macro file you want to protect,
followed by a name for the backup copy. For example, if
you’re protecting QAMACRO.ASC, you can name the
unprotected backup file QAMACRO.BAK.—Ed.]
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